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DesignSpark Mechanical 5.0 release overview  
 

This release of DesignSpark Mechanical introduces new features, enhancements and user 

customization which are detailed in the following notes. Apart from the listed, general fixes have 

been applied to improve user experience. 

Here’s a quick summary of what’s new: 

1. Customizable shortcuts - You can assign shortcut keys to quickly run any command 

supported by DesignSpark Mechanical 

2. Views Panel, allow saving views – create any number of custom views to quickly make edits. 

3. Measure and Quality tools – analyse your geometry for the size and shape of bodies as well 

as the quality of bodies created. 

4. Mass Properties – a tool to get volume information on designed objects 

5. Equations – sketch with mathematical equations 

6. Flythrough – a display mode with camera setup to explore inside complex objects 

7. Improved Sketch – new constraint-based sketching tools and dedicated 3D sketch mode 

8. Enhanced shading - displays objects with shading when exposed to ambient lighting in real 

life. 

9. Custom rendering- adjust the faceting on a per-object basis and for the overall design to get 

a balance between optimal performance and quality of design output. 

10. Pattern of planes – quickly generate a plane pattern to slice objects quickly into equal parts 
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Sketching 
When the sketch grid is highly skewed, Spin while in sketch mode or cross section mode now snaps to the 

center of the grid or edge of the grid depending on mouse location. This ensures that the grid does not spin 

wildly by picking a spin location on the expanded grid. 

 

Constraint based sketching 
 

Constraints can now be added while sketching to more easily create sketches to exact sizes and shapes.  With 

the introduction of sketch constraints, sketch tools have been moved to their own tab in the ribbon. 

 

If you do not see this independent ‘Sketch’ tab yet, you can enable it via File -> DesignSpark Options -> 
Advanced. Then, click OK to save the change and restart the software. 
 

 

When you open DesignSpark Mechanical next, you will see the sketch group moved out to its own dedicated 
tab. 
 
Tools in the Sketch Constraints group allow you to reduce the degrees of freedom (place constraints) on the 

drawing objects in 2D drawings and designs. Adding constraints restricts the type and range of movement of 

the objects, and links objects such that certain editing tasks on one drawing object will cause linked objects 

to be modified. 

You can Save and Open models containing Sketch Constraints. Designs that include Sketch Constraints will 

open in Sketch mode. Leaving Sketch mode will trigger the deletion of all constraint data.  



 

  

WWW.DESIGNSPARK.COM/MECHANCAL PAGE 4 

 

DESIGNSPARK MECHANICAL 5.0 - RELEASE NOTES

Certain normal sketching tools included rudimentary tangency and coincident constraints (enabled with the 

Maintain Connectivity option), but these are easily overridden during drawing editing. Sketch Constraints 

tools offer many additional types of constraints which can be applied to any of the standard drawing objects 

(line, circle, arc, and so on) and are more robust. 

 

The following constraints can be added to your Sketch Constraints: 

• Parallel 

• Perpendicular 

• Concentric 

• Fixed 

• Coincident 

• Equal Radius 

• Tangent 

• Horizontal 

• Vertical 

• Midpoint 

• Equal Distance 

• Dimension 

Notes: 

 Most of these constraints require two selected drawing objects. The first selection is the target and 

will generally be moved to satisfy the constraint. The second is the anchor object and will generally 

remain in position. The cursor symbol changes to indicate the type of constraint and whether you 

are selecting target or anchor. 

For example: 

First selection for Parallel:  

Second selection for Parallel:  

 Fixed, Horizontal and Vertical constraints require only one selected drawing object. 
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 The Fixed constraint tool acts as a toggle – click an object to apply, click a second time to remove. 

 The Equal Distance constraint uses on-screen tool guides to determine the anchor and target. See 

the example below. 

 Concentric and Equal Radius constraints propagate when modifying the curves. 

 Equal Radius constraints are added automatically when you create multiple rounded corners using 

the Ctrl key and the Create Rounded Corner tool, within a Sketch Constraint. All the rounds created 

this way maintain an Equal Radius constraint so that changing the size of one will change all of them. 

By comparison, in normal Sketcher, the rounds are equal radius during creation only. After creation, 

they do not maintain an association and can have their sizes changed independently. 

 You can make objects fully constrained, or well-defined. Fully constrained objects have no degrees 

of freedom and are highlighted in dark blue in the design window. 

 It is possible to over-constrain your drawing object(s). Over-constrained objects will be highlighted 

in red. This also applies to dimensionally over-constrained lines. One or more constraints must be 

removed before you can proceed with your design. 

 

To add an Equal Distance constraint 

The Equal Distance constraint uses on-screen tool guides to determine the anchor and target distances, and 

to create the constraint. This is because more than one selection is often necessary to create the constraint. 

1. Activate the Equal Distance constraint in the Sketch Constraints group.  

2. With the Target tool guide active, select your moveable drawing object or pair of geometries to define the 

first dimension. A dimension line with the target symbol is added to the design page. 

 

 

3. Select the Anchor tool guide (or hold the alt key), and then select your stationary drawing object or pair of 

geometries. A dimension line with the anchor symbol is added to the design page. 

 

 

4. Click the Complete tool guide to create the constraint. The target object will be modified as required. 

Note: A dimension between two lines will force the lines to be parallel. 
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To add Dimension constraints 

1. Activate the Dimension constraint in the Sketch Constraints group. 

2. Select an individual sketch object, or two objects as required for certain types of dimensions. Move the 

cursor away from the object to position the dimension. The normal behavior for applying and locating 

dimensions is observed. However, when applied as a constraint, if you attempt to edit one object, other 

objects may be modified to maintain the dimension constraint. 

Notes: 

 Dimension constraints may be used to modify the size of the selected object. After creating the 

dimension constraint, double click to select the dimension and then modify the value. 

 Dimensions may be positioned vertically, horizontally, or aligned with the object. 

 Angle dimensions are supported – select the first object and then hover over the second object until 

the angle dimension appears. Move the cursor to position the dimension. 

 Arc length dimensions are supported – hold the Ctrl key while selecting the arc to create an arc length 

dimension. Move the cursor to position the dimension. 

You can create multiple Sketch Constraints on different planes as well as multiple Sketch Constraints on the 

same plane. The active Sketch node is shown in bold in the tree. The parent Plane containing the active 

sketch node is italicized. 

Note: Constraints may be applied within sketches but not between sketching planes. 

 

To create multiple Sketch Constraints in a single design 

1. Create a new sketching plane. 

2. Right-click on the plane and select New Super Sketch on that plane. Existing sketches are hidden, and a 

new Sketch node is added to the selected Sketching Plane in the tree. 

The previous sketch remains active temporarily until you start sketching in the new Sketch Constraints. 

Note: Coplanar Sketch Constraints can reside on different containing planes. 

 

To switch between existing Sketch Constraints 

1. Right-click a plane, and then select Activate Curve Container from the context menu. The last active Sketch 

Constraints on the plane will become the active Sketch Constraints. 

2. Alternatively, right-click on a Sketch Constraints in the Structure tree, and then select Activate Super 

Sketch. The selected Sketch Constraints becomes the active Sketch Constraints and will be indicated in bold 

in the tree. 
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Viewing Constraints 

Select Show Constraint Tips  in the Constraints group to view the constraints applied. 

Hover over the constraint tip to see the type of constraint. The geometries involved will be highlighted dark 

blue. 

 

If multiple constraints are applied, click the drop-down to see all the constraints applied. 

 

 

Deleting constraints 

You can delete constraints using the Delete Constraint tool in the Constraints group or using the option from 

the mini-toolbar. 

 Using the Delete Constraint tool: 

Select Delete Constraint in the Constraints group. The Delete Constraint tool is available when Show 

Constraint Tips is enabled. 

Select the constraint to be deleted. In case of multiple constraints, click the drop-down and then 

select the constraint to be deleted. 

 Using the option from the mini-toolbar: 

 

1. Right-click on a drawing object in the Sketch Constraints. In addition to the context menu, a mini 

toolbar appears at the cursor location. 

 

2. Click the drop down next to the Delete icon to see the list of active constraints on the selected 

drawing object. For example, 
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Note: if the drawing object is a point, the mini toolbar and drop down will be simpler, containing only the 

point’s constraints. If multiple drawing objects are selected, the drop-down panel will contain the constraints 

common to all the selected objects. 

Alternatively, click the red X to delete a constraint. The list of active constraints is shown. 

3. To check which geometries are involved in a constraint, hover over the constraint’s symbol in the 

drop-down panel. Geometries involved will highlight in red. For constraints involving a point, the 

point’s parent curve will highlight dashed as well, to help distinguish it from other overlapping points. 

If applicable, related constraints will highlight in yellow. Related constraints will be affected by 

changes to the highlighted constraint. Circles constrained to have equal radii could be an example of 

related constraints. 

4. To delete a constraint, click on the constraint’s symbol in the drop-down panel. The symbol will gray 

out. If the sketch was in an over constrained state, the sketch may adjust if a solution is now 

achievable. 

 

To use Sketch Mode Mirror in Sketch Constraints 

1. With Sketch Constraints active, sketch a line in the desired mirror position. 

2. Use the right-click context menu, select Set as Mirror Line to set up the mirror. Now, when you sketch, the 

entities are mirrored about the Mirror Line as you sketch them. Constraints applied 

3. With multiple Mirror Lines, entities are mirrored about each mirror line whether they are perpendicular 

or not. 

4. To stop creating mirror constraints, uncheck Set as Mirror Line. 

Notes: 

 Splines are not supported with a Mirror Line, but the other Sketch tools are. 

 A Fixed constraint is automatically applied to the mirror line to ensure more predictable dragging. It 

is possible to delete this constraint but dragging behavior may deteriorate. 

 Equal Radius constraints are made automatically when creatingmultiple Rounded Corners with a 

Mirror Line. 

 To delete Mirror (Symmetry) constraints individually, click on an entity to open the mini toolbar. 

Individual constraints can be removed using the Delete dropdown menu. 

 

Referencing Existing Geometry 

It is possible to create constraints and dimensions to cross sections and edges that lie in the sketch plane. 

Such cross sections and edges are treated as reference curves and will not be changed. Creating a Sketch 

Constraint or dimension requires at least one non-reference curve to allow for the constraint to be 

satisfiable. 

 



 

  

WWW.DESIGNSPARK.COM/MECHANCAL PAGE 9 

 

DESIGNSPARK MECHANICAL 5.0 - RELEASE NOTES

3D sketching 

Enabling this option hides the sketch grid and allows you to connect objects with lines/curves in the 3rd 

dimension. You may already be familiar with this capability from earlier DesignSpark Mechanical versions but 

v5 now introduces a button to quickly switch between 2D/3D sketch modes. 

 

 

 

Sketch Equations 

You can now use the Equation tool  in Sketch group to create curves based on mathematical equations. 

 

You can select from a number of preset equations or write custom equations in Sketcher. 

 

The image below shows a Sine Wave equation. 

 

The equation is constructed in the Options panel. The image below shows the equation for the Sine 
Wave shown above. 
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You can enter an equation in the input fields for X and Y. Z is for 3D equations. You can enter a value 
to offset the curve in the Z-direction. Clicking the icon to the right of the X, Y, or Z input fields opens 
an editor for more complex equations. 

To create a preset equation: 

1. Click the Equation tool  in the Design tab 

2. (Optional) Click the Set Grid Location tool guide and select a different sketch plane 

3. Choose an equation from the Curve Types dropdown list in the Options panel 

4. Edit the equation as needed in the Options panel 

5. Click Complete  to create the equation curve 

To create a custom equation: 

1. Click the Equation tool in the Design tab 

2. (Optional) Click the Set Grid Location tool guide and select a different sketch plane 

3. Choose Custom in the Curve Types dropdown list in the Options panel 
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4. Enter the equation in the input panels 

5. To create a Parameter to use in the equation enter it in square brackets "[ ]" 

o For example: [L] 

o The parameter is added to the Parameters list in the Options panel 

6. Click Complete  to create the equation curve 

To save a custom equation: 

The Save Custom Equation button next to the Curve Types dropdown menu allows you to save your custom 
equations. They are saved to an XML file in the following location: 

%APPDATA%\Roaming\SpaceClaim\SketchCurveEquationCustoms.xml  

Saved equations are added to the Curve Types dropdown menu and can be used in other documents and 
across multiple sessions. If you do not see a newly saved equation in the list, open/create a new document 
or close and re-open the current document. 

To edit an equation curve: 

1. Click the Equation tool  in the Design tab 

2. The Select Curve tool guide is active 

3. Select the curve to edit 

4. (Optional) Click the Set Grid Location tool guide and select a different sketch plane 

5. Edit the equation as needed in the Options panel 

6. Click Complete to create the equation curve 

Editing an Equation Curve in 3D is limited to the range of the equation. For example, if a Sine curve has a 
range of 4π, you can Pull an end to anywhere within that range. You cannot make it longer (e.g. 6π) 

If the curve has been Split, the ends of any of the pieces can be Pulled within the range of the original 
equation. 

To scale an equation curve: 
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Use the Scale parameter and slider in the Options panel to scale an equation curve. The Scale tool in Sketcher 
and 3D scaling with the Pull tool also work on equation curves. 

Syntax and predefined functions: 

 Parameters include a name and are enclosed in square brackets [L] 

 Functions include a function name followed by parenthesis containing any values as arguments 

o For example: Sine([t]-[r]) 

 The table below shows common predefined functions included 

 

Name Description 

Abs Returns the absolute value of a specified number 

Acos Returns the angle whose cosine is the specified number 

Asin Returns the angle whose sine is the specified number 

Atan Returns the angle whose tangent is the specified number 

Cos Returns the cosine of the specified angle 

Sin Returns the sine of the specified angle 

Sqrt Returns the square root of the specified number 

Tan Returns the tangent of the specified angle 

 

Preset curve examples: 

The preset curves include those shown in the following table. All curves have default values. 

Sine Wave  

 

Involute of Circle  
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Cosine Wave  

 

Lemniscate 

(Bernoulli)  

 

Archimedes 

Spiral  

 

Limaҫon  

 

Catenary  

 

Lissajous  

 

Epicycloid  

 

Logarithmic Spiral  

 

Epitrochoid  

 

Normal 

Distribution  

 

Hypocycloid  

 

Tractrix  
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Hypotrochoid  

 

Trochoid  

 

 

There are also 3D curves included in the presets. These are shown in the table below. All curves are at default 
values. 

Helix 

 

Slinky 

 

Line 

 

Viviani's 
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Split 
 

In the Split tool, you can now box-select multiple planes to be used as cutters for splitting edges. 

Select the edge to Split. 

 

 

Box-select the planes to split the edge. 

 

 

The edge is split by the planes. 
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Box -select has also been added for selecting Edges and Curves in the Split tool. 

Selecting an edge loop to split in the Split Body tool has been enhanced to work on a hollow tube. 

 

 

Measure 
 

General 
A new Measure tab is included in DesignSpark Mechanical v5 to better understand the size and shape of 

bodies as well as the quality of bodies created. 
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With a whole body selected, the Measure tool now reports the overall X, Y, and Z extents of the body. 

 

 

 

Mass Properties 
 

Use the Mass Properties tool to display volume information for the objects in your design. 

If you use the tool on a surface, it will display the total surface area. If there are multiple surfaces on the 

same plane, the tool displays the total surface area for all the surfaces. 

 

To view mass properties of an object 

1. Click Mass Properties in the Inspect group on the Measure tab. With the Select Body tool guide 

active, select a solid in the Structure tree or by selecting it in the Design window to display its volume, 

center of mass, and principle moments and axes. 

2. A small origin appears at the center of volume with its axes oriented in the direction of the principle 

axes. To calculate the principle moments and axes for another point, hold Alt and select an origin to 

add it to your selection. 

 

Check Geometry 
 

The Check Geometry tool allows users to check for potential errors in their geometry.  This has been 

accessible through the structure tree by right clicking on a body but is now also available through the 

Measure tab.  In order to use this tool a solid must be selected before the tool can be used. 
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Normal 
 

The Normal tool will display the normal direction of faces or surfaces in your design. The normal direction is 

the "outside" of the face or surface. The normal can be flipped on surface models.  The normal of a surface 

will determine which way the Pull arrow is displayed when selecting a surface. 

Normals can be displayed with either an arrow or by color in the options panel of the tool. 

 

Grid 
 

The Grid tool can display the curves that define any face or surface in your design. This tool displays a visual 

representation of the mathematical expression of the surface. The grid lines represent the mathematical 

expression used to generate the surface. You can use it to identify low quality surfaces. For example, a face 

may look fine, but the underlying mathematical representation is unnecessarily complicated or poorly 

parameterized. You would have problems changing the face using other tools. 

If you find a face with underlying problems, you can delete the face, then use the Fill tool with the Patch 

Blend option to generate a new face. 

Grids can be displayed with a grid display, checker display or wire display. 
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Curvature 
 

The Curvature tool can be used to show curvature values along faces or edges. You can use this analysis to 

identify areas with very tight curves that can be difficult to offset or turn into thin solids. 

You can also use the visualization to evaluate curvature continuity along a set of faces or edges. Curvature 

continuity is when the curvature values change in a smooth, continuous manner. You can see continuous 

curves because the data points will gradually change length or the transition between face coloring is even 

and smooth. Sudden changes in the length of the data points or color on a face indicates non-continuous 

curvature. 

Scale and Density options can be used to control the display on edges and Color options can be used to 

control the maximum and minimum curvature display on faces. 

 

 

Dihedral 
 

The Dihedral tool can be used to visualize tangency (or lack of tangency) between two faces. You won't see 

any data points if you select an edge between two tangent faces. Non-tangent faces will show data points 

because the angle is more than 0. The larger the angle between the faces, the longer the fringe lines will be 

at each test point. 

 

 

Color, Scale, and Density can be used to control the display of the Dihedral lines. 
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Draft 
 

The Draft tool will help you identify the amount of draft and direction on each face in a design. 

You can use this tool to analyze parts that will be molded. Faces shown in red (the default color for a negative 

draft angle) may not release properly from a mold. You should input the draft angle you consider necessary 

for proper release. The draft angle may depend on a number of factors, including material choice and design 

constraints. 

 

 

 

Toolguides can be used to specify the direction to calculate the draft from.  If Shadow lines are turned on 

within the options, the Draft Curve toolguide can be used in order to turn shadow lines into actual curves.  

This is useful for creating parting surfaces for a mold. 
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Stripes 
 

The Stripes tool will reflect an infinite striped plane on the selected faces (or on all the faces of the selected 

solid). This tool is useful to show how the smoothness of a surface. 

Use this tool to visualize and check tangency and curvature continuity between faces. For example, two 

surfaces may appear to have a smooth transition, but the Stripes tool will reveal an irregularity. 

 

In the example above, the area marked with A has good continuity. The stripes line up almost perfectly across 

the edge. The area marked with B does not have good continuity. The stripes do not quite line up at the edge. 

Color and Density options can be used to control the display on a face. 

 

Deviation 
 

The Deviation tool can be used to show the distance from a source, or reference, body to a selected body or 

Mesh body. Use this analysis to see how closely the geometry of the two bodies match up. For example, you 

would use the Deviation tool when you reverse engineer a design from stl data to see how closely your design 

matches the faceted body. 

 

 

 

Sample points will be taken at each node on a faceted body or on the edges and faces of solid bodies.  The 

number of sample points can be increased by using a percentage of the body size or a fixed length. 
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In addition to Color, many display options can be used in order to visualize the deviation between the two 

bodies such as: 

 Shading - Use textured shading to indicate deviation 

 Porcupine - Use lines to indicate deviation 

 Sample points - Show sample points in the deviation display 

 Target - Show the target body in the display 

 Transparent Target - If the target body is displayed, show it as transparent 

 

Selection 
 

The Selection filter can now be set to Bodies. This makes it easier to single select bodies and differentiate 

between faces and bodies during a box select. 
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The Rounds power selection option in the Selection panel has been improved. You can now select rounds 

within a range of values, including equal or smaller radius rounds. 

Graphics 
 

General 
You can now see the effect of a color change on the model display. Pre-highlighting over a color in the Color 

palette will show the effect of the color change on the model. 

 

An Add datums to scene image option has been added to SpaceClaim Options > Appearance. 

When checked, this option will include currently visible Datums (Planes, Axes, Origins) with the image when 

you click the right-mouse-button > Copy Scene. 

 

Opacity under Color tool has been changed from a slider to a pickbox. 
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Style Override, in the Style group of the Display ribbon, allows you to toggle a body’s display to be either 

Opaque or Transparent. If any subset of the body’s faces is made transparent, Style Override will now be 

disabled, because there is a mix of opaque and transparent faces. 

 

Views Panel 
A new panel is included that controls view states as well as allowing new views to be saved and accessed 

through shortcuts.  Custom views can be deleted if they are no longer needed but standard views cannot be 

removed. 

 

When creating a new view, you can control the name, shortcut, orientation, and object visibility.  If object 

visibility is on, bodies will be hidden or shown when switching views. 
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A right mouse button context menu will allow you to modify a custom view after it’s been created. 

 

 

Flythrough Mode 
 

Flythrough is a display mode intended to give you the impression you are inside the model looking around.  

Within the display tab a user can turn the camera options on and control where the camera is located through 

a second viewport. 

     

When setting up a flythrough mode, typically the screen is split with one viewport to show the camera 

position and one for flying through. 
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The Camera can also be moved along a trajectory.  This is helpful for setting a dynamic flythrough through a 

design along a spline or set of curves. 

 

 

 

Hold the ALT key to spin about the Camera position, which is likely a distance away. Notice the Spin Center 

in the image below. 

 

If you do not hold the ALT key, the Spin Center is located within the model geometry based on where on the 

screen you press the middle-mouse-button. 
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Enhanced Shading 
 

The Enhanced Shading option displays solids and surfaces with shading representing the exposure of the 

scene to ambient lighting. Shadows and highlights improve the rendering. 
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In the example, the image on the left is rendered with Enhanced Shading while the image on the right shows 

the regular shading. 

The Ambient Occlusion Only option can be used to render the display with a diffuse, non-directional shading 

effect that approximates how light should be shining on any specific surface based on the light source and, if 

included, the environment. The shading represents the exposure of the scene to ambient lighting, for 

example, interior surfaces of a model are typically more occluded and will appear darker than the exposed 

outer surfaces. This option can be used when the Enhanced Shading option is enabled.  The Ambient 

Occlusion Only option is available within the Show button on the far right of the Display tab. 

 

 

 

In the example, the image on the left is rendered with Ambient Occlusion Only, while the image on the right 

is rendered with only the Enhanced Shading option. 
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Custom Rendering 
 

Per-Body Custom Tessellation settings have been added so that you can customize the faceting of objects. 

 

 

In SpaceClaim Options, Rendering Quality now has a Custom setting. This applies to all bodies. 
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When set to Custom, you can change: 

 Surface tolerance is the distance between Facet Edges and the actual surface. It’s a measure of 

how close the facets are to the real geometry. 

 Normal tolerance is the angle between adjacent Facet Normals. It’s a measure of the smoothness 

of the faceting. 

 Max edge length sets a limit for Facet size. Smaller Facets match the real geometry better than 

larger ones. 

 

You can also customize faceting on individual bodies in the Properties panel with the new Tessellation 

Quality Level setting. 

 

When set to Custom, you can change the Surface, Normal, and Max edge length tolerances for the selected 

body. 
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Move 
 

Symmetric Move now works on Datum Planes. Previously, the planes would move in the same direction, 

not opposite directions. 

 

 

Patterns 
 

Patterns of Planes can now be selected (in the Structure Tree) as cutters for the following tools: 

• Combine 

• Split 

• Split Body 

This allows for one-click creation of many bodies. The images below show an example using the Combine 

tool. 
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You can also use Shift-Select to select the first and last planes to use only a portion of the planes in the 

Pattern. 

Overall Pattern Length is now locked by default. Previously, Pattern Pitch was locked. 
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Software options 
 

Customize command shortcuts 
 

You can assign shortcut keys to quickly run any command in DesignSpark Mechanical.  

Example: the F2 key is allocated to PAN. When you press F2, you can simply pan across the object with your 

left mouse button or a touch pen. 
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Quick Export Options 
For paid Exchange/Bundle add-on users, STEP and IGES formats can now be quickly exported from the 

drop-down list in the Design tab. 

 

 

For Japanese users, 3D print quotations can be obtained from the Kabuku service. 

 


